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Chapter

Visualizing Data

Db2 Web Query for i Designer is a web-based development tool that you can use to
quickly and easily create content from your data and use that content to create pages,
within a single visualization or by assembling multiple distinct content items into a
separate visualization. You can manage your data using data flows and use that data to
create charts, reports, and interactive and responsive pages, all in one place.

Using Db2 Web Query Designer, you can prepare raw data from a variety of sources in a
data flow, and turn it into easily usable and understandable data sources for subsequent
analysis. You can also join multiple data sources as if they were a single data source,
and then create new content from your joined data. Db2 Web Query Designer provides
you with a simple, but powerful, set of features to create content directly within a
visualization using a variety of chart types and tabular report layouts, allowing you to
communicate the information in your data as effectively as possible. You can continue
adding as much new content to a visualization as you want, each in its own container or
grouped into multi-content containers using tab, accordion, or carousel behavior.
Alternatively, you can create these pages using existing content such as charts, reports,
images, and URLs that you have saved in your environment. With the interactive page
canvas, you can resize and rearrange resources in the visualization into your preferred
layout. Additionally, interactive filter behavior allows you to control the display of data in
the visualization with ease, and In-Document Analytic capabilities allow you to continue
interacting with your content beyond design time.

In this chapter:

.4 Navigating the Db2 Web Query for i Designer Interface
. Creating Content in Db2 Web Query for i Designer

d Selecting a Data Source
d

Configuring Sample Data Settings
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Navigating the Db2 Web Query for i Designer Interface

Db2 Web Query Designer is divided into a Data tab, which provides options to prepare, profile,
and join your data sources, and a Visualization tab, where you can create charts and reports
using that data and arrange your content on a page. When creating a visualization with existing
content, only the Visualization tab is available, since you do not specify a data source.

Using the Data Tab
To access the Data tab, select DATA on the Db2 Web Query Designer toolbar.

The Db2 Web Query Designer Data tab with no joins is shown in the following image.
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The Data tab includes the following tools and components.

1 Db2 Web Query Designer Toolbar. Provides features that affect the entire data flow and
visualization. It includes the following options:

.4 Application menu. Includes the following options:
.d New. Creates a new visualization in Db2 Web Query Designer.

-1 Open. Opens an existing chart, report, page, or visualization in Db2 Web Query
Designer.

- Save. Saves the current visualization.
- Save As. Saves the current visualization as a new file.

. Close. Closes Db2 Web Query Designer.
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Advanced Options. Includes diagnostic information to help you validate and
troubleshoot your data flow. The following options are available:

.4 View Source. Displays the source syntax of the data flow, including all synonyms
and Joins.

.d Session Log. Opens the Session Log dialog box, which includes a record of server
configuration and activity.

.4 Clear Session Log. Deletes all entries from the session log.

.4 Clear Undo/Redo History. Deletes all undo and redo records.

Undo. Undoes the previous action.

Redo. Available when you have undone an action. Redoes the last undone action.

View. Allows you to hide or show the Join Editor and Resources tree.

Resources tree. Allows you to select synonyms from your application path that join to the
data source to use for your visualization.

Canvas. Shows the tables in your data flow. You can drag a synonym from the Resources
tree onto a data source in the canvas to create a join.

Canvas toolbar. Provides options to configure your data flow or the canvas interface. The
following options are available:

_I

-

Get Data. Opens the Get Data dialog box, where you can select additional data sources
to be joined with your original data source.

Add Join. Displays potential Join candidates from a relational database, including
confidence scores.

Clear Join. Removes the Join from the data flow. You can also right-click the Join object
or a synonym joined to the original data source, and click Delete to remove the Join.

Note: Before deleting a recursive Join (when a table is joined to itself) you must remove
any fields with active content from the first instance of the table.

Canvas options. Displays the following options:

. Flow view. An icon represents each synonym, and a container that displays the type
of join represents each join.

d Model view. A list box represents each synonym, and a vector between the joined
synonyms represents each join.
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-l Arrangement. Select a Layout option to define the spacing between objects on the
canvas, or click Auto Arrange to reset the display of objects in the canvas to the
default arrangement:

Vertically spread out.
Vertically compressed.
Vertically compressed with long H-space.

Default.

L U LU U u

Auto Arrange.
1 More options. Sets the following Join defaults:

- Insert child segment with snowflakes. No is the default, which inserts only the
segment selected. You can select Yes to insert the selected segment and all of
its descendants.

- Display full component names. Yes is the default. Full component names are
field names qualified/prefixed with the synonym and segment name.

d Use Monotree. Yes is the default. The monotree view displays the current folder
in the Data panel and provides navigation to other folders. Select No to display
all folders in a traditional tree view.

-l Show undo/redo button with history. No is the default. Select Yes to display the
history button.

- Data sheet. The current state of your data is reflected in the Data sheet, which shows a
data sample in a tabular format similar to a spreadsheet. The Data sheet appears when
you select a synonym on the canvas.

- Join Configurator. When a join has been created, allows you to modify it by changing the
join type, the join operator and expression, and the fields used in the join.

-1 Sample data. When a join has been created and you select the Sample Data tab, sample
values for the joined synonyms are displayed together in a single table.

- Join Profiler. When a join has been created and you select the Join Profiler tab, a join
analyzer chart displays the number of matching values from each part of the join and the
total number of values included in the data source as a result of the join. To the right of
this chart, a key fields grid shows LHS and RHS match states.
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To create joins in Db2 Web Query Designer, drag a synonym from the Resources tree onto a
synonym in the canvas to which you want to create a join. A join is created automatically based
on common field names and values, but you can change the default join using the Join
Configurator. For more information, see Joining Data.

Using the Visualization Tab

The data flow defined in the Data tab is used to create content in the Visualization tab. In the
Visualization tab, you can create charts and reports and arrange them on a page in different
types of containers, or you can create a visualization from charts, reports, images, and more
that you have created and saved previously. If you are creating a visualization with existing
content, you can access items in your workspaces and add them to your visualization.

To create a visualization with new content, on the Db2 Web Query Hub, click the plus button
and then click Create Visualizations. Alternatively, on the Db2 Web Query Home Page, click
Visualize Data, or click the plus button and then click Create New Visualization. To assemble
existing content into a visualization, click the plus button on the Hub or Home Page and then
click Assemble Visualizations.

The Visualization tab displays, as shown in the following image.
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The Visualization tab includes the following tools and components.

1. Db2 Web Query Designer toolbar
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Visualization toolbar
Sidebar

Resources panel
Properties panel
Canvas

Filter toolbar
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Content picker

The position of each item is indicated by the associated number in the following image.
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Using the Db2 Web Query Designer Toolbar

The Db2 Web Query Designer toolbar includes a set of options and controls that affect the
entire interface or the entire visualization. The toolbar is shown in the following image.

-~
= Db2 Web Query for i | Designer I —— E

The following table lists the controls that you can access from the Db2 Web Query Designer
toolbar.
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Icon

Description

Application Menu. Opens a menu that includes the following
options:

-1 New. Creates a new visualization in whichever mode you are
using, allowing you to create new content or to assemble a
visualization from existing content.

.d Open. Opens an existing chart, report, page, or visualization.
.4 Saving Options.
-l Save. Saves the current visualization.

When the visualization contains a single chart or report,
you can choose to save it as a FOCEXEC procedure (single
chart or report file) or as a page (file that supports
multiple charts and reports in a user defined layout). If the
visualization contains multiple charts or reports, the
visualization is always saved as a page.

I Save As. Saves the current visualization as a new file.
4 Export As.

4 Data. For single items only, download a data extract, with
the fields used in your content, as a .xIsx Excel
spreadsheet.

. Image. For single items only, download a .png image of
your chart or report in its current state.

.4 Close Designer. Closes Db2 Web Query Designer.

Save. Opens the Save dialog box, where you can save the
visualization to a specific location in your environment.

When the visualization contains a single chart or report, it saves
as a single chart or report file. When the visualization contains
multiple items, whether it was previously saved as a single item
or you are saving it for the first time, it is saved as a compound
document with multiple content items within it.

Visualizing Data

11



Navigating the Db2 Web Query for i Designer Interface

Icon Description
) Undo. Undoes the previous action.
c Redo. Redoes the last undone action. Available when you have

undone an action.

DATA VISUALIZATION Data and Visualization tabs. Allows you to toggle between the
Data tab, where you can add joins to your data source, and the
Visualization tab, where you can create new content items or
import existing items in a responsive page.

Hide/show panes. Allows you to hide or show the Resources
panel, Properties panel with Settings and Format tabs, and
Content picker.

Using the Visualization Toolbar

The Visualization toolbar includes contains options that are specific to the Db2 Web Query
Designer Visualization tool. The Visualization toolbar is only accessible from the Visualization
tab. The Visualization toolbar is shown in the following image.

Lol B T~ I Live data: 1000 Qutput Format: HTMLS ~ )

The following table lists the controls that you can access from the Visualization toolbar.

Icon Description

+ Add data. When creating a visualization with new content, click
this button to select a data source. This button is not available
when building a visualization from existing content.

Add container. Adds a new panel container to a page. If the
visualization is being created with new content, you can build a
new chart or report in the container. If the visualization is being
assembled from existing content, you can drag a content item
into the new container.

12
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Icon Description

1 Convert to page. When creating a single content item, converts

ke the visualization from a single item to a page.

Y- Filter options. When creating a visualization with new content,
allows you to enable or disable on-chart filtering and determine
filter chaining behavior.

1.0' Add to filter bar. When you add external content with parameters

to a page, this button appears. Click it to create filters on the
Filter toolbar for all parameters. Expand the menu and click
Choose filters to add to page to select which specific filters to
create.

Settings. When creating new content, opens the Canvas Data
Limit dialog box, where you can change the following settings:

[ Live data: 1000

4 Preview data. Allows you to choose to show a representative
data sample, live data in order from the data source, or
generic test data values in the canvas at design time when
creating new content.

4 Record limit. When sample data or live data are selected,
allows you to specify the number of records from the data
source to display in the canvas at design time when creating
a chart.

4 Enforce limit. When using live data, determines whether the
record limit should be applied post-retrieval, to aggregated
records, or at the source, to records in the data source.

These settings affect all new content items on the page. For
more information, see Configuring Sample Data Settings on page
68.

Visualizing Data 13
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Icon

Description

Output Format: HTMLS

Output Format. Allows you to select an output format for stand-
alone charts and reports. The following options are available:

AHTML
HTML5
HTML
PPTX

XLSX

L U U o o U

Select at runtime

Pages created from new content always use the Interactive
output format. For more information, see Changing Output
Formats in a Chart or Report.

Info. When creating a visualization using external, existing
content, enables an informational mode that changes the view of
all content items on the canvas to display their paths in the
repository and parameters configured within these items. This is
useful to identify which filters affect which items.

[

Run in new window. Runs a preview of the page in a new
browser tab, allowing you to keep a run-time view of your content
available as you develop it. When you click Run in new window
again, the content is reloaded in the same new tab.
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Accessing Resources From the Db2 Web Query Designer Sidebar

The sidebar contains tabs that allow you to access, modify, and view properties for different
elements and items in a visualization. Each tab in the sidebar displays a related set of
resources and options in the Resources panel. The tab selected in the sidebar is indicated by
a line next to it, as shown in the following image, where the Fields tab is selected.

n
+|im
WJtline

Fields
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Viewing the Structure of a Visualization

The Outline tab provides a high-level overview of all of the items in a visualization, including all
pages, page sections, visualization containers, and content items. The Resources panel when
the Outline tab is selected is shown in the following image.
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When you first open Db2 Web Query Designer, the visualization consists of a single chart or
report. Only this item appears in the outline. You can right-click the item to view its Db2 Web
Query language source syntax.

Once additional visualizations are added, page, section, visualization, and content levels
appear in the Outline, as the visualization transforms from a single content item to a page.

The item that you select for editing in the canvas is highlighted in the outline. You can also
click an item in the outline to select it, as an alternative to selecting it from the canvas.

You can right-click an item in the outline to access a relevant set of options. For example, if
you right-click a section, you can rename it or add a new visualization to it if you are creating
new content. You can right-click a container to rename or delete it. Right-click a content item to
rename it, duplicate it, or to remove it if it's in a multi-content container. If the item was
created in the visualization, you can view the Db2 Web Query source syntax or save the item
as a separate file.

When the visualization has been transformed into a page, the outline also includes the
JavaScript and CSS options, which allow you to add custom code to style and add run-time
behavior to your visualization. This code can reference classes that you specify for visualization
components using the Classes property.

16
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Accessing Fields and Variables
You can click the Fields tab to display fields from the data source in the Resources panel. The

Resources panel when the Fields tab is selected is shown in the following image.
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You can use these fields to create content by double-clicking them, dragging them into a
bucket on the Properties panel, or dragging them directly onto your content on the canvas. The
bucket to which the field is added determines how the values display in your content.

If you drag a field onto an empty area of the canvas, a new container is created. If you drag a
field onto the title bar of a container, you are presented with the option to replace the content
in the container or add the content to the container as a new tab, accordion panel, or carousel
slide. If you drag a field onto a chart, report, or map, then it is added to that content item in
the default bucket for the field type.

Right-clicking a field provides further options, depending on the type of field. These options
include the ability to add the field to the chart or the filter toolbar, use a dimension field as a
measure or a measure field as a dimension, create bins for measure fields, or create a define
field using the selected field. You can also create a define using the menu to the right of the
Dimensions and Measures sections.

You can control how fields and variables are presented by using the View Selector menu, which
is shown in the following image.
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The following options are available:

. Field layout. Choose how the fields in your data source are organized. Folder view is the
default.

.4 Folder view. Organizes fields into folders based on segments and field hierarchies
defined in the data source.

d Flat view. Lists all fields in alphabetical order on the same level instead of grouping
them into folders.

- Split dimensions/measures. By default, dimension fields and measure fields in the data
source are separated into different sections of the Fields tab, highlighting the different
roles they perform in sorting and aggregating the values in your content. You can deselect
this setting to show all fields in a single pane. This option is unavailable when viewing the
Variables tab.

. Field identifier. You can choose how fields are identified in the Fields tab. By default, field
titles display. You can choose to show the field name or field path and name instead.

4 Show title. Displays field titles in the Fields tab. The field title is a logical name defined
in the data source that is used in axis labels, column headers, tooltips, and other
areas.

-1 Show name. Displays field names. The field name is the literal name of the field listed
in the data source.

.4 Show path and name. Displays qualified field names. This option shows the field name,
as well as the file and segment where the field is located.

.4 Enforce paths. Selecting Enforce paths means that any joins in your data are automatically
checked to ensure that all fields are connected. If a field is used from a table that is not
joined to another table whose fields are being used, Enforce paths will not allow that field
or any other fields from the disconnected table to be used, ensuring that the request
executes successfully. This option is deselected, by default.

You can search for a field or a variable using the search bar. Type a text string into the search
bar text box to filter for fields or variables whose titles or names contain that string. The list of
fields or variables refreshes dynamically to display values that contain the string. The string
can appear at any point in the field name or title.

To clear the search query, delete your search query or click the X button in the search bar, as
shown in the following image.

ship "L\,D‘
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The search bar X button is browser dependent, so it may not appear in certain web browsers.
For example, it is available in Google Chrome, but not in Mozilla Firefox.

The fields in your data source are available from the Fields tab. By default, if the data source
uses folders to organize the fields that it contains, these folders are reflected in the Fields tab.
This folder organization is called a business view. For dimension fields, these folders could be
field hierarchies defined in the data source or segments in the data based on different tables
that have been joined together. Measures can also be grouped based on segments.

™ =

Icons identify whether a folder is a basic folder or a hierarchy ==, and whether a field is a

character "*, geography &, , date 2 , OF numeric field. Calculated fields are indicated by
a function symbol added to the field icon.

By default, the Fields tab is divided into two sections, one for dimension fields and one for
measure fields.

Dimension fields are categories that sort and organize the values in your data. For example,
product categories, customer names, geographic locations, and dates are all commonly used
as dimensions. In a chart, each value in a dimension field often defines a separate section of
the chart. For example, each dimension value might be represented by a riser in a bar chart, a
slice in a pie chart, or a point in a scatter plot.

Dimension fields in your data source can be organized into hierarchies, where the top field is
the most general and the bottom field is the most specific. The following image shows a
hierarchy of product fields.

= & Product
: Product,Category
: Product Subcategory
+ i Mode

Note: Hierarchies in cube data sources do not include a Values list in Db2 Web Query
Designer.
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Some dimension fields can also be expanded to show attributes. Attributes are other fields
that provide additional information about field values. Each attribute field value is correlated to
a value of the field that it describes. For example, in the following image, the attribute fields
for the Customer City field, listed in the Customer, City Details folder, provide information such
as the latitude, longitude, and population of each city value.

- = Customer
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i CustormerBusiness Sub Region

-+
[

% Customer,Country

4

5 CustomerState Province
& Customer,City
= B Custormer, City Details
2 Customer City Latitude
2 Customer,City, Longitude
ke Custormer City,Population
ke Custormer City, Population,Range
2 CustomerCity,GIS Point
+ 2 CustomerPostal Code
+ i Full Name
Measure fields supply quantitative values for each category defined in a chart or report, often
providing aggregated values in a report or sizing components, applying a color scale, or

appearing in tooltips in a chart or map. Measure fields typically use a numeric field format. You
can add up to 16 measure fields to a chart or report.

Visualizing Data 21
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To add a field to your content, double-click the field or drag it from the Resources panel on the
Fields tab into a bucket or onto the canvas. When creating a chart, different buckets are
configured to use different kinds of fields. For example, in a vertical bar chart, a measure field
added to the Vertical bucket is used as a measure to aggregate the sort values in the chart by
determining the height of each bar. On the other hand, putting a dimension field in the Vertical
bucket creates matrix rows for each dimension value, breaking the chart into multiple smaller
charts. Therefore, you will typically use at least one measure field in this bucket to define
different bar heights. Similarly, you will typically use a dimension field in the Horizontal bucket
for a bar chart in order to determine the values that each bar represents. If you use a measure
field in the Horizontal bucket using the Add as dimension option, a bar will be generated for
each value in the measure field.

Some chart buckets accept both measures and dimensions but display them differently. For
example, the Color bucket in a bar chart creates a color scale for measure fields, and assigns
colors to values in a legend for dimension fields.

In a chart, if a bucket is designed to use only measure fields or only dimension fields, you
cannot drag an incompatible field into it from the Fields tab. To indicate this, the cursor

changes to a cancel sign ® when pointing to an invalid bucket. For example, when creating a
vertical bar chart, you cannot drop a measure field into the Horizontal bucket, or a dimension
field into the size bucket.

Instead, to add a measure field to a dimension bucket, right-click the field in the Fields tab and
click Add as dimension. The field is added to the default dimension bucket, and appears in
blue, indicating that it is a dimension, as shown in the following image.

Horizontal

Similarly, to use a dimension field as a measure, right-click it and click Add as measure. The
field is converted to a measure by applying the CNT. aggregation function, which provides a
count of data records, and added to the default measure bucket. The field appears in green,
indicating that it is a measure, as shown in the following image.

Wertical

| CNTProduct Category

You can then move the field into another bucket that accepts measure fields.
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You can also right-click the aggregated dimension field in a measure bucket and point to
Aggregate to change the prefix operator aggregation from count (CNT.) to count distinct
(CNT.DST.), which provides the number of distinct values for the field, or percent of count
(PCT.CNT.), which computes percentages based on the number of instances found.

The Tooltip bucket, meanwhile, behaves somewhat differently. The Tooltip is a measure bucket
that displays field values in the tooltip when you point to an area of a chart. Unlike other
measure buckets, you can drag a dimension field directly into the Tooltip bucket. The
dimension is aggregated using the FST. prefix operator, so the first value of the field is
displayed in the tooltip. This ensures that the dimension field generates only one value for the
tooltip. The Tooltip bucket is best used when each area of the chart is associated with a single
value of the selected tooltip fields. As with any bucket, you can right-click a field in the Tooltip
bucket and point to Aggregate to change the aggregation.

Since reports simply display field values based on the rules for each bucket, with no
dependencies based on field type, they do not have these limitations. All distinct values are
shown for any field dropped into the Rows or Column Groups buckets, while values are
aggregated for any field added to the Summaries bucket.

The Rows bucket creates a row for each unique value in each field within it, while the Column
Groups bucket creates a set of measure columns for each unique value. These buckets sort
the aggregated or detail values in the report. You can add multiple fields to the Rows and
Column Groups buckets to display more granular information in a report.

The Summaries bucket aggregates measure field values for each sort value of the Rows and
Column Groups fields in the report. Adding multiple fields to the Summaries bucket creates
multiple measure columns in the report. These measure columns are repeated for each
column group value, if there are any fields in the Column Groups bucket.

Visualizing Data 23
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While the Summaries bucket is the default measure bucket, it is not the only option for
displaying measure values. You can use the display options to change the Summaries bucket
to the Counts, Details, or Details with counter bucket to display different information for the

fields within it. The display options can be accessed above the buckets from the Calculation
Options menu, as shown in the following image.

Settings Format
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The Counts bucket, enabled by selecting the Counts display option Jm“ aggregates values in
the report by displaying the number of records for each field within it, for each sort value. The

Details bucket, enabled by selecting the Details display option E , does not aggregate the
values of the fields within it. Instead, it displays all values for the selected fields. The Details

with counter bucket, enabled by selecting the Details with counter display option — , displays

all values for the selected fields, similar to the Details bucket, and also counts the rows for
each primary sort field value.
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You can add fields to other areas, as well. If you drag a field to the Filter toolbar, you can
create a filter for the field. If the field is a character field, you can select values from a list. If
the field is a numeric field, you can use a slider to specify filter values. If the field is a date
field, you can use a calendar to select dates or use a predefined date range.

If you drag a field into a header or footer, the field is used as a parameter to dynamically
provide a value in the header or footer text. The first value found for the field is displayed at
run time. Using a field in the header or footer is especially useful if that field is also used to
filter your content or if it is used as a multipage field in a chart or to create breaks in a report.
The following image shows Db2 Web Query Designer with the Customer Country field added to
the header of a chart that is filtered to only show data for the United States.

Customer Country
United States
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The following image shows the chart at run time. The chart header displays United States,
which is the value of the Customer Country parameter.
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You can manipulate fields from the Fields tab, as well. You can right-click a field to add it to
your content, create a filter for it, or create a calculated DEFINE field using the field that you
selected. If you right-click a dimension field, you can add it to the chart as a measure. When
you do this, an aggregation function that calculates a count of the dimension values is applied
to the Dimension, and the field is placed in the bucket.

Similarly, you can right-click a measure field and add it as a dimension. In this case, the
measure value in each row of the data source is used as a sort value in the chart. You can
right-click a dimension and click Group values to create groups, or right-click a measure and
point to Bin values to create bins. Groups are groups of related values, and bins are ranges of
values. You can use groups and bins to create new sort fields for your content. For example,
bins are used in histograms to plot the distribution of data values. Each bin value generates in
a bar in the histogram.



1. Visualizing Data I

You can right-click a measure or dimension once they are added to your content to access

additional options. For example, if you right-click a dimension added to a chart, you can change
the location of the axis, the sort order, create a compute, and more, as shown in the following

image.
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If you right-click a measure added to a chart, you can set it to use a logarithmic scale, which is
useful when there large disparities between values on the same axis, set sorting, apply an
aggregation function, use a quick transform, and more, as shown in the following image.
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In the Fields tab of the Data pane, you can also create a calculation that runs before
aggregation (DEFINE) or after aggregation (COMPUTE) by clicking the ellipsis buttons on the top
right of the Dimensions and Measures panes, and clicking Add calculation, as shown in the
following image.
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The Variables tab contains a list of variables and preset filters defined in your data source, as
well as default system variables. To add a variable to the chart to use as a filter, drag it into
the Filter toolbar.

Adding Filters to Pages Assembled From External Content

When you assemble a page from existing content, using the Assemble Visualizations option,
the Filters tab on the sidebar allows you to display and chain filter controls. When you add an
existing chart or report to a page, Db2 Web Query Designer identifies any parameters present
in the item. A badge appears on the Filters tab on the sidebar, indicating that you can add
filters to the page, as shown in the following image.

Filters

When you open the Filters tab, the Add all filters to page button and a list of parameters from
the content items on the page display. Click Add all filters to page to create filter controls for all
of the listed parameters, or right-click each one and click Add to page to add them individually.
Once added, the visibility icon next to the parameter is no longer faded.

Below each parameter on the Filters tab is an expandable list of Bindings. The Bindings list
shows the data source and target items on the page that are associated with each parameter,
providing information about each filter. Click a target item in a Bindings list to briefly highlight
the border of that item on the page in order to easily locate it.
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Note: Numeric, date, and date-time filter bindings do not indicate the associated data source,
but you can click the Info button on the Visualization toolbar to see which data sources are
used for the associated target items in order to determine the data source for each filter
parameter.

Filters for fields that are part of the same hierarchy in the data source are automatically
chained. This means that when you select a value from one of the filter controls, the other
controls are filtered and updated based on the value that you select, ensuring that you can
only select valid filter values. You can also manually apply chaining by dragging one parameter
onto another in the parameter list. The filter becomes a child, for chaining purposes, of the
field onto which it was placed. To unchain a parameter, drag it into the empty space between
the Add all filters to page button and the top parameter in the list. The parameter is removed
from the chaining hierarchy and moved to the bottom of the list.

Chaining relationships are indicated by indents in the parameter list. Filter controls are chained
to any filters indented under it in the list. For example, in the following image, the Category
filter is chained to the Product Model filter, so when you select a category, the list of available
models in the filter control updates.

Filters Collapse all
== Add all filters to page
[ — @ Category: ]

+ ¢ Bindings
- @@ Product Model:
+ ¢ Bindings
— @ Region:
+ ¢ Bindings
— @ Store Type:
+ ¢ Bindings
In this example, selections from the Category filter do not affect the Region or Store Type
filters, since they are not part of the same chaining hierarchy, and, since filtering in an

assembled page is unidirectional, values selected from the Product Model filter do not chain
back up to the Category filter.
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Accessing Containers and Widgets

The Container tab provides a selection of container types and widgets that you can use in your
visualization.

The Container tab is shown in the following image.
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Using this tab, you can select empty containers and widgets that you can drag to the canvas
and populate with the content of your choice.

The types of containers available to you include the following:
Panel

Tabbed

Carousel

Accordion

Grid

U U o o o o

Panel group
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The panel, tabbed, carousel, and accordion container types are used to hold content, such as
charts, reports, or images. You can add multiple content items to a tabbed, carousel, or
accordion container and navigate between them using the paging behavior of the container.

When assembling a visualization from existing content, you can add multiple filter controls to
cells in a grid container as an alternative to or in addition to the Filter toolbar, providing more
freedom in the placement of your filter controls. The panel group container, meanwhile, can
contain multiple other containers within it, allowing you to keep them together when responsive
folding occurs in the visualization.

The Container tab also allows you to access the Link Tile and Explorer widgets. The Link Tile
widget allows you to click through from a content item displayed on the page to a target item
from your Repository. You can configure the Link Tile using the Link Tile options on the
Settings tab of the Properties panel. The Explorer widget allows you to embed the Workspaces
view of the Hub into a Db2 Web Query Designer page that can be added to a portal, allowing
users to create new content and access existing files in the Repository.

Adding Existing Content to a Visualization

You can add existing content to a visualization from the Content tab. This content can be a
Db2 Web Query procedure such as a chart or report, a URL, an image, and more.
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The Content area provides access to the Resources tree, where you can navigate to your
content. The initial view of the Resources tree displays the directory in which the page is
created. You can navigate to other workspaces and folders using the back arrow. Each item on
the tree is represented by a thumbnail, making it easy to locate content. The following images
show the Resources tree displaying two different levels of the repository hierarchy. The first
image shows folders and items within the Portal folder.
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The second image shows the content in the Small Widgets folder, within the Portal folder. You
can click the name of the folder, in this case, Small Widgets, to return to the parent folder.

Content Y
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(-3 Category Sales
Regional Sales Trend
sams Liscount by Region
:— Regional Profit by Category
»*.* Average Costv Sales
‘s P2 Average Cost vs Revenue Scat..
Product Profit Line By Month

Revenue Product Bar

Revenue Region Bar

You can use the search bar to find an item more easily. Once you have typed a search term, to
return to the view of all items, delete the text in the search bar, or, in certain browsers, click
the X button.

Drag a content item onto the visualization canvas or into a container to add it. If you drag
content onto a container that already contains content, you are asked whether you want to
replace the content in the container or add a new tab, accordion panel, or carousel slide to it.
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Adding Text and Buttons to a Control Area

When assembling existing content into a visualization, you can use the Control tab to add a
text label or Submit and Reset buttons to a cell in a filter control area, such as the Filter
toolbar or a grid container.

The Control tab is shown in the following image.

i Basic Controls N
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You can add empty controls to the Filter toolbar or a filter grid if you want to select the
particular types of filters to use in your page before binding specific filter parameters to them.
To add an empty filter control, drag one of the following filter controls into a filter cell:

Button set
Calendar
Checkbox
Double list box
Dropdown
Input

Radio

Slider

Submit
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Toggle
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Some filter controls can only be used under specific conditions. For example, the calendar
control can only be used with date and date-time fields, and the slider can only be used with
numeric fields. The toggle control only takes the first two values from your data set, so it best
used with Boolean fields. Others are best suited to selecting either a single value or multiple
values. For example, the check box and double list box are commonly used with multi-select
parameters, while the radio button control is commonly used with single-select parameters.
Still others, like the input edit box and toggle control, can only accept a single value, and so
should always be used with single-select parameters.

You can use a text label to add contextual information to a filter cell. The Submit and Reset
buttons, meanwhile, change the filter behavior so that instead of refreshing the page to apply
filtering whenever a user makes a control selection, the page does not refresh until the user
clicks Submit. This is useful when you have many filter controls on a page. The Reset button
allows the user to reset all filter controls to their default selections. The options on the Control
tab cannot be used when creating new content in a visualization.

Once added, you can choose to delete either the Submit button or the Reset button to include
the functionality of just one of these buttons.

To add a text label or Submit and Reset buttons to a visualization, drag the object into a cell in
the Filter toolbar, a modal filter window, or a grid container.

Modifying Object Properties

You can view and modify the properties of an item on the page, including content, containers,
filter controls, and pages, from the Properties panel. The Properties panel includes
configuration options on the Settings tab and styling and formatting options on the Format tab.
The Properties panel appears to the right of the Resources panel, and changes based on the
item that you have selected in the canvas.
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The Properties panel for a bar chart is shown in the following image.
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When you select a chart or report, the Properties panel shows a list of buckets on the Settings
tab. Drag a field from the Resources panel with the Fields tab selected into a bucket to add it
to your content. The buckets that you place your fields into determine how they are displayed.

When creating a chart, depending on the type of chart that you create, you may see some of
the following buckets:

d Vertical
Horizontal
Size
Color
Tooltip
Animate
MultiPage
Measure
Detail

Geo
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Group

When creating a report, you can use the Rows and Column Groups buckets to sort a report
based on the values of the fields in those buckets. The Summaries bucket aggregates
measure field values based on these sort values.

The Settings tab also includes the Filter bucket. The Filter bucket allows you to create static
filters specific to a content item, as opposed to the Filter toolbar, which creates prompted
filters that affect the entire visualization. To create a static filter, drag a field from the
Resources panel into the Filter bucket. You can specify filter values using the Add Filter dialog
box with a set of controls appropriate to the type of field that you are filtering.
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You can use the display options, available from menus above the buckets on the Settings tab,
to change the display of values in your content. When creating a report, the display options
allow you to change the Summaries bucket to the Counts, Details, or Details with counter
bucket to display different information for the fields within it, as shown in the following image.
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When creating a chart, the display options additionally allow you to modify its structure,
depending on the chart type. The layout display options for a bar chart are shown in the
following image.

Display ~

ul
LI
|
™
1
al

Vertif & &= Stacked
I Side-by-Side
o I Apsolute
= Percent
Size

In addition to changing the display of measure values and the layout of the chart, you can
swap the axes in eligible charts and clear the fields from all buckets.

The menu to the right of each bucket label also provides different options for charts and
reports, depending on the bucket. These options include the ability to clear the bucket, create
a new calculation in a report, or split the y-axis for multiple measures in a bar, line, or area
chart.
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When placed in certain sort buckets, fields display icons indicating the sort order of the field
and provide an option to use the field as a matrix row or column if it is used as a dimension,
or switch y axes to create a dual-axis chart, if the field is used as a measure in certain chart
types. In the following image, the Vertical bucket contains a matrix row field and a vertical axis
measure field.
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You can also right-click a field in a bucket to access options pertaining to that field. These
options include field format, sorting, aggregation options, and more.

Below the field container buckets in the Display area, you can access the Filters and Content
areas. The Filters area includes the Filters bucket. You can drag a field into the Filters bucket
to create a static filter. Static filters affect only the selected content item, and cannot be
modified at run time.

The Content area includes a variety of options to modify the structure and behavior of the
chart. You can show or hide the header and footer areas for charts and reports, add row and
column totals to reports, and enable Auto Drill and Auto Linking for single content items. For
single-content charts only, you can also enable automatic refresh and enable Insight. Auto
Drill, Auto Linking, and Insight provide run-time interactivity to your content, expanding the
amount of information accessible from a single item. Automatic refresh allows you to reflect
changes to your data source in real time by updating your content at set intervals.

When editing content, the Format tab provides access to options to style your content and
change the output format. For a report, you can change the theme and, for a stand-alone
report, the output format. The theme applies an overall set of styling properties to the entire
report, while the output format allows you to change the type of file generated at run time.
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When editing a chart, the Format tab provides access to even more options. You can use the
Quick Access menu at the top of the Format tab to access styling options for different sections
of a chart, such as the legend, axes, or different series. You can also access options for
different sections of a chart by right-clicking an area of the chart on the canvas and clicking
Style. The General options include the ability to change the theme and output format, as well
as styling the chart frame and background color.

When you select a container in a visualization that has been transformed into a page, the
available options on the Properties panel allow you to style the container and configure its
behavior within the visualization as a whole. On the Settings tab, you can change display
settings such as whether to include a title or toolbar on the container and on which types of
devices the container should be visible. You can also allow content customization and provide
cascading style sheet class names that you can use in custom CSS and JavaScript code. The
Format tab allows you to change the style of the container. The Style options are based on the
selected theme, which you can change using the Theme option on the Format tab when you
select an entire page. The selected theme is also applied to content in the visualization, by
default, although you can specify a different theme for each chart or report.

When you select a section of a page, which is a horizontal area of the visualization that
contains one or more rows of containers, you can use the Settings tab to assign CSS classes,
make the section collapsible, and set the height of the section. On the Format tab, you can
select a style to change the background color of the section. You can add more sections to the
visualization by right-clicking the first section, in the space directly surrounding the containers
in the visualization, and clicking Insert section above or Insert section below.

You can select an entire page of a visualization by clicking the page toolbar or the area of the
canvas below all of the sections on a page, or by using the outline. When you select the page,
you can use the Settings tab to assign CSS classes and show or hide the title and toolbar for
the page. On the Format tab, you can change the theme for the entire page, the page margins
and maximum width of the page, and the appearance of the page heading text.

Using the Db2 Web Query Designer Canvas

The canvas displays the current state of your content as you create it. You can select items in
the canvas to edit them, drag resources such as fields or containers onto the canvas to add
them to your content or page, and use on-chart filtering to create filters based on visual
selections.
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The canvas also contains, if enabled from the Properties panel, heading text for each
component, as well as optional footers for charts and reports. You can double-click this text to
edit it, and then type new text, make styling changes to header and footer text using the text
toolbar that appears, and even drag a field into the header to create dynamic header text that
displays the first available value for the field at run time.

Initially, if you choose to create a visualization with new content, the canvas allows you to
create and edit a single chart or report.

The chart or report fills the entire canvas. Some options are only available when creating a
single content item. For example, you can only enable Auto Drill or Auto Linking for stand-alone
content items and only make a stand-alone item an Auto Linking target.

When creating a single content item, two canvas behaviors are available. The output format
that you use determines which of these behaviors is used.

At design time, the AHTML and HTML5 output formats use the responsive canvas. Reports
present In-Document Analytic paging controls at the bottom of the report that allow you to
navigate through it. Some report styling properties are unavailable when using the responsive
canvas. Charts in these output formats present informational tooltips and allow on-canvas
filtering at design time.

The HTML, PDF, PPTX, and XLSX output formats, on the other hand, use a paginated canvas at
design time. Some report styling properties are only available when using the paginated
canvas. You can scroll through an entire report using a scrollbar, and charts do not present
interactive options, such as tooltips.

At run time, the HTML5 and HTML output formats are functionally equivalent. The two options
are available to allow you to use the two different canvas types. For more information about
output formats for charts and reports, see Changing Output Formats in a Chart or Report.
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You can create multiple new content items on a page. To transform a single item into a page
without adding a second container, click Convert to page. Once you have converted a chart or
report into a page, you can drag a container onto the page from the Resources panel when the
Container tab is selected on the sidebar. Click and drag a container from the Resources panel,
and drop it in the desired location. An empty container is created, to which you can add
content. Alternatively, with the Fields tab selected on the sidebar, click and drag a field into an
empty area of the page to create a basic panel container with a default content item that uses
the selected field. The canvas with two containers is shown in the following image.
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Once a container is placed on the page, you can click and drag the container toolbar to move
it. A blue highlighted area shows where the container will be dropped. If necessary, other
containers on the page will move to accommodate the placement of the container that you
have moved.

If you point to a container, a set of sizing handles appears. If you click and drag one of these
handles, you can resize a container on the page. The contents of the container automatically
resize to fit the new container dimensions.

The same types of components are available in a page assembled from existing content.
These pages are created by clicking the plus button on the Db2 Web Query Hub or Db2 Web
Query Home Page and clicking Assemble Visualizations. When assembling content into a
visualization, you cannot edit individual, external content items. However, additional options
are available for certain components. For example, you can change styling and default values
for filter controls, style and rearrange the filter grid, and unlock a container for run-time
customization. When assembling a page from existing content, if you hold the Ctrl key, you can
select multiple containers, controls, or sections to apply the same changes to each.
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You can click and drag to select an area of a new chart created in a visualization to filter it.
When you make a selection, a tooltip appears, giving you the option to filter for the values in
the selected areas of the chart, or filter the visualization to exclude those values. A filter
control is added to the Filter toolbar, and all content created in the visualization is affected,
allowing you to filter your content quickly and intuitively. To clear the filter, remove the filter
control from the toolbar. The filter is removed from all affected content.

The canvas shows a design view of your content. To see a full run-time view of your
visualization, with run-time functionality such as drilldowns, In-Document Analytics, and more,
click Run in new window on the Visualization toolbar. Your content runs in a new browser tab or
window.

Filtering a Visualization From the Filter Toolbar

Filters in Db2 Web Query Designer can utilize one of two behaviors. These are static filters and
prompted filters. Static filters are always applied to your content whenever it is run, and allow
you to apply consistent filter values without prompting the user to make filter selections. They
are applied to a single content item at a time, and can only be added to new content.
Prompted filters, on the other hand, allow users to select the filter values to use in your
visualization at run time. When you create a prompted filter, a control appears on the Filter
toolbar, allowing you to make filter selections. The user can see these controls and make
selections from them at run time. Run-time controls are not displayed for static filters.
Prompted filters can be created for new content, or added to a visualization from referenced
content.

Prompted filters are created, accessed, and modified from the Filter toolbar. You can create a
prompted filter in one of the following ways:

. Drag a field from the Resources panel to the Filter toolbar.

.4 Right-click a field from the Resources panel or a bucket in the Properties panel and click
Add to filter toolbar.

- Use on-chart filtering to select areas of a chart on the canvas.

.4 Add external content that includes dynamic parameter filters to a page.
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The Filter toolbar is displayed below the page heading in the following image.

Page Heading

Product Category SUM.Quantity Sold
All 300,000:1,114,332

When creating a prompted filter in a new chart or report, you can click a control on the Filter
toolbar to change the filter selection, or right-click the it to access additional filtering options,
such as making the filter required, changing the aggregation, changing the number of values
that can be selected, or changing the filter operation from value selection to exclusion.

Right-click a prompted filter generated for external content to change the control type or merge
controls for the same field. You can also use the options on the Settings and Format tabs to
set default values for the filter, specify how the filter interacts with items in a page or portal,
and style the filter.

Different types of filters provide different controls on the Filter toolbar. Filters on alphanumeric
fields provide a list from which you can select values, measure fields provide a slider on which
you can provide maximum and minimum values, and date fields provide a calendar from which
you can select a range of dates or use a default range option.

Changing Content Types

You can use the Content picker, on the right-side of the Db2 Web Query Designer interface, to
change chart and report types in your visualization.

When a chart or report is selected, the Content picker allows you to select a chart type or
report layout. This includes the ability to change your content from a chart to a report in
addition to changing to different varieties of each content type.
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By default, the Content picker is collapsed, allowing you to scroll through common options, as

shown in the following image.
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You can click the arrow at the bottom of the Content picker to expand it to display all content
options, including additional report layouts, different map types, additional chart types, and
chart extensions that you have enabled in your environment. The expanded Content picker is
shown in the following image.
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When you change the chart or report type, fields may need to be rearranged in, and in some
cases removed from, their buckets to accommodate the new type. You can rearrange them as
needed.
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Procedure: How to Create a Visualization With New Content in Db2 Web Query Designer

Db2 Web Query Designer provides a wide variety of content creation options, allowing you to
create new charts and reports in a page, or create a page with existing content. If you create a
visualization with new content, you can also customize the data that you use in your content by
joining additional tables to your original data source.

The following are a general set of steps that you can use to create new content in Db2 Web
Query Designer:

1. On the Db2 Web Query Hub, click the plus button and then click Create visualizations.
Or, on the Db2 Web Query Home Page, click Visualize Data.
Db2 Web Query Designer opens in a new browser tab.
In Db2 Web Query Designer, click the Add data button to select a data source.

3. Select a workspace and a data source available from that workspace.

Once you select a data source, Db2 Web Query Designer loads with options to create a
single content item.

4. Start by creating a new chart or report.

a. From the Content picker, select a content type. You can choose from different chart
types and report layouts.

b. With the Fields tab selected on the sidebar, drag fields from the Resources panel into
the buckets in the Properties panel to create content.

You can also double-click a field or drag it onto the canvas to add it to the default
bucket for that field type.

c. Optionally, filter your content by dragging a field into the Filter toolbar or Filters bucket.

Prompted filters in the Filter toolbar affect the entire page, while static filters in the
Filters bucket affect only the item for which they were created.

d. Use the options of the Format tab of the Properties panel to style your content.

Once you've created content, you can save it as a single item or turn the visualization into
a page.

5. If you want to create a page with multiple content items, click Add container on the
Visualization toolbar to turn the visualization into a page.

The first item you created is moved into a container, and a second container is created.

To create a page that contains the single item that you have created, click Convert to page
on the Visualization toolbar. The item is moved into a container, but a second container is
not added.

Visualizing Data 49



Navigating the Db2 Web Query for i Designer Interface

Procedure:

50

6. Continue adding content to the page. You can create a new container by dragging one from
the Container tab on the sidebar, or click Add container to create a hew container. You can
then create a new content item as outlined in step 4. You can also drag a field from the
field list onto an empty area of the canvas to create a new container with content using
that field.

7. Select different areas of the page and style and format them using the options on the
Properties panel.

The entire page, sections, containers, filter controls, and filter cells all have their own set
of styling and formatting options.

8. Once you have finished creating your visualization, save it. You can also preview the
visualization to see run-time behavior by clicking Run in new window.

You can now add your visualization to a portal and share it with others. If you created a
single content item instead of turning the visualization into a page, the item can be added
to new visualizations as external content.

How to Create a Visualization With Existing Content in Db2 Web Query Designer

Db2 Web Query Designer provides a wide variety of content creation options, allowing you to
create new charts and reports and create pages with new content, or create pages using
existing content. If you have created charts and reports in Db2 Web Query Designer,
InfoAssist, or other content creation tools, or if you have external items such as images and
URLs, you can add them to a page that uses external content.

The following are a general set of steps that you can use to create content with existing items
in Db2 Web Query Designer:

1. On the Db2 Web Query Hub or the Db2 Web Query Home Page, click the plus button and
then click Assemble Visualizations.

Db2 Web Query Designer opens in a new browser tab.

2. In Db2 Web Query Designer, select a template for the page. You can use a predefined
template, or select Blank to build the page from scratch.

3. Add content to the page. Click Content on the sidebar and navigate to an item in the
Resources panel, then drag onto the canvas. Alternatively, you can create a container for
an item first by clicking Container on the sidebar and dragging a container on to the
canvas, and then add content to the container.

4. Continue adding content to the page. You can create a new container by dragging one from
the Container tab on the sidebar, or clicking Add visualization. You can then click Content
on the sidebar to access items that you can add to containers on the page or drag directly
onto the canvas.
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5. If the content that you added to the page includes dynamic parameter filters, an indicator
appears on the Filters tab on the sidebar. Select the Filters tab and then click Add all
filters to page to create controls for all parameters in your content, or right-click a specific
parameter in the list and click Add to page to create a control for it.

6. Select different areas of the page and style and format them using the options on the
Properties panel.

The entire page, sections, containers, filter controls, and filter cells all have their own set
of styling and formatting options.

7. Once you have finished creating your visualization, save it. You can also preview the
visualization to see run-time behavior by clicking Run in new window.

You can now add your visualization to a portal and share it with others. If you created a
single content item instead of turning the visualization into a page, the item can be added
to new visualizations as external content.

Navigating Db2 Web Query Designer With Keyboard Controls

You can use keyboard commands to navigate through the Db2 Web Query Designer interface to
perform certain content creation tasks without a mouse.

Press the Tab key to navigate between adjacent sections of the user interface, or press Shift +
Ctrl + F10 to open a menu of sections of the user interface to quickly jump from one section to
another if they are not near each other. You can jump to one of the following areas of the
interface:

. Db2 Web Query Designer toolbar.

4 Visualization toolbar.

L

Sidebar.

L

Properties panel.

L

Canvas.

- Template picker.

Press the Enter key or Spacebar to select the item or area that is currently in focus. The arrow

keys can be used to navigate through a section of the interface. For example, use the Up Arrow
and Down Arrow keys to navigate through the field list, and the Right Arrow and Left Arrow keys
to expand and collapse folders.

Context menu options can be accessed by pressing the Menu key E‘ or by pressing Shift +

F10. For example, to add a field to a chart or report, navigate to the field, press the Menu key,
focus on Add to chart or Add to report and press the Enter key or Spacebar.
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When you select a container on the canvas, you can use the arrow keys to move the container
and use the Shift key and an arrow key to resize it. Shift+Right Arrow expands the container to
the right, while Shift + Left Arrow contracts the container from the right. Similarly, Shift + Down
Arrow expands the container downward, while Shift+Up Arrow shrinks the container from the
bottom. You can use the Delete key to delete the selected container.

You can also use keyboard commands in a page at run time. Use the Tab key to navigate
between areas, buttons, and controls on the page, and press the Enter key or Spacebar to
execute a button command or open a menu. When using filter controls, you can use the Tab
key to navigate to different sections of the control, use the arrow keys to navigate to different
values, use the Enter key to select values, and use the Esc key to close the control and apply
the filter. At run time you can also press Ctrl + Shift + F10 to open a menu that allows you to
jump to different areas and containers on the page, once you have started to navigate within it.

Basic Guidelines for Building Accessible Pages in Db2 Web Query Designer

When building pages in Db2 Web Query Designer that are intended to be accessible, there are
some basic guidelines that you can follow.

Before creating your pages, you will need content with which to populate them. When creating
authored pages that are converted from a single content item, you build this content directly
within the page. When assembling pages from existing content, your content is saved as
stand-alone charts and reports. Since many charts rely on visual cues in order to communicate
information, such as data categories and values, it may be preferable to use reports where
possible. If it is necessary to use a chart, adding data labels can be a compromise, as in
some chart types, the screen reader reads out data labels as the user navigates through the
content. When creating reports, it may be advisable to limit the number of fields that you use.
This helps reduce the number of values in the report, making it easier to navigate.
Simplification is always a best practice when creating accessible content.

Content items that you add to your page reside in containers. These can be basic panel
containers, which each contain a single content item, or they can be a tab, accordion, or
carousel container, which can hold multiple items on different tabs, accordion panels, or
carousel slides, respectively. Although each of these container types is accessible, when
building accessible pages, using basic panels without sub-panel sections can provide a more
intuitive user experience.

When adding filters to a page, keep in mind that certain filter controls are easier to navigate
than others. If possible, avoid using the calendar control to filter a date field. Instead, consider
the option of using content items with separate filters for individual date components, such as
years, quarters, months, or days. These component filters can use a drop-down control, which
is easier to navigate.



1. Visualizing Data I

You can improve the accessibility of your filter controls by adding a tooltip with information
about the type of control and the values that the user can select. To add a tooltip to a control,
select it and, on the Settings tab, in the General Settings area, type text for the Tooltip property
that you want to display when you point to the control at run-time. You can also double-click
the control label on the canvas to type a more descriptive title for the control. By default, the
title of the field is used.

Procedure: How to Create New Content in Db2 Web Query Designer

Use the following the following steps to create a new chart or report, which you can transform
into a page, in Db2 Web Query Designer.

1.
2.
3.

Visualizing Data

On the Db2 Web Query Home Page, press Ctrl + Shift + F10 to open the navigation menu.
Use the Down Arrow key to navigate to Toolbar and then press the Enter key.

Press the Tab key twice to navigate to the Visualize Data button, and then press the Enter
key.

Db2 Web Query Designer opens in a new tab, where you are prompted to select a data
source.

In the Select Data Source dialog box, use the Tab key to navigate to the Workspace menu.

Use the Down Arrow key to expand the Workspace menu and navigate to a workspace in
your environment from which you can access the data source that you want to use, then
press the Enter key to select it.

The file explorer in the Select Data source dialog is populated by the application folders,
Master Files, and Reporting Objects available from the selected workspace.

Use the Tab key to navigate to the Flat View button. Press the Enter key to switch to the
flat view in the file explorer, making all data sources available for selection without having
to navigate into subfolders.

Use the Tab key to navigate inside the file explorer. Use the Down Arrow and Up Arrow
keys to navigate to the data source that you want to use, and then press the Enter key to
select it.

The Db2 Web Query Designer canvas loads, and you can begin creating your content.

To save your content, press Shift + Control + F10 to open the navigation menu. Navigate
to Tool Menu and press the Enter key. Press the Enter key again to open the Application
menu. Use the Down Arrow key to navigate to Save, and then press the Enter key. The
Save dialog box opens. Use the Tab key to navigate to the Save button, and then press
the Enter key.
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When you run a page created in Db2 Web Query Designer, you can use keyboard controls to
navigate through different page components, including page and panel toolbars, filters, and
sub-container sections. Components are labelled for screen reader use.

To quickly jump to a specific section of the page, press Ctrl + Shift + F10 to open the
navigation menu. Otherwise, navigate from the top of the page using the following steps.

If you are using JAWS as your screen reader, press Insert + Z on your keyboard to enter Forms
mode, allowing you to set values for controls more easily.

1.

From the Db2 Web Query Home Page, press Ctrl + Shift + F10 to open the navigation
menu. Press the Space bar to open the Header submenu, then press the Down Arrow key
three times to focus on the Workspaces option. Press the Enter key to navigate to the
Workspaces option on the Db2 Web Query Home Page toolbar, and press the Enter key
again to open the Workspaces view.

In the Workspaces view, navigate to the page that you want to run. Press Shift + F10 or
the Menu key to open the shortcut menu. Press the Down Arrow key to navigate to the
collapsed Run menu. Press the Space bar or Enter key to expand the run menu. With
focus on Run in new window, press the Enter key to run the page in a new browser tab or
window.

Press the Tab key to start navigating the page. The first element should be the page title.

Press the Tab key again to move to the next element, which is the Refresh button, by
default. Press the Enter key to refresh all items on the page.

Press the Tab key to navigate to the Hide Filter button. The filter bar displays by default if
there are any filters added to it. Press the Enter key to hide the filter bar, and press the
Enter key again to show the filter bar again.

Press the Tab key to navigate to the Export to file menu. By default, you can export a page
as a PDF or a .png image. When creating the page, you can set options to export only one
file type, in which case this menu becomes a button, or not allow export. Press the Enter
key to expand the menu, use the Down Arrow key to navigate to an export file type, and
press the Enter key again to export a snapshot of the page. To close this menu without
selecting an option, press the Esc key.

Press the Tab key to navigate to the filter bar, if there are filters added to the page. Once
you have placed focus on a filter control, you can set filter values using a different set of
steps, depending on the control type.

d To select values from a drop-down list, press the Space bar to open the drop-down
menu. Use the Down Arrow and Up Arrow keys to navigate through the list of values,
and use the Space bar or Enter key to select values. Press the Esc key to close the
drop-down menu and apply your selections. If the filter is single-select, the menu
closes as soon as you select a value.
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10.

Visualizing Data

- To select values from a list of check boxes or radio buttons, use the Tab key to
navigate through each item in the list. Press the Space bar or Enter key to select or
clear a check box or select a radio button. Check box controls allow you to select
multiple values, while radio button controls allow you to select a single value.

d To select values from a button set, once you have placed focus on the control, press
the Tab key again to enter the control, then use the Left Arrow and Right Arrow keys to
navigate between values in the button set. Press the Enter key or Space bar to select a
value. A button set may be single select or multiselect.

d To select a date range from a calendar control, once you have placed focus on the
control, press the Space bar to open the date picker menu. This menu provides the
ability to clear the date range, select a range from a list of preset options, or set a
custom date range.

-l To set a numeric range using a slider control, once you have placed focus on the
control, use the Left Arrow and Right Arrow keys to set the lower end of the slider, then
press the Tab key and use the Left Arrow and Right Arrow keys to set the high end of
the slider. Once you are done setting the slider range, press the Tab key to advance to
the next page component.

Once you have navigated through all filter controls, press the Tab key to navigate to the
title bar of the first container. Press the Tab key again to navigate to the Maximize button
on the container. Press the Enter key or Space bar to maximize the container, and press
the same key again to collapse the container once it has been maximized.

Press the Tab key again to navigate to the run-time menu of the container. Press the Enter
key or Space bar to open the menu and place focus on the Refresh button. Press the
Enter key or Space bar to refresh the content in the container. Press the Esc key to close
this menu without refreshing the container.

If the container includes multiple content items on separate tabs, accordion panels, or
carousel slides, press the Tab key to navigate to the first sub-containers. You can navigate
to each sub-container using different methods depending on the container type.

4 To navigate between tabs in a tab container, press the Tab key to navigate to the first
tab, then use the Right Arrow and Left Arrow keys to focus on different tabs. Press the
Enter key or Space bar to display the selected tab.

4 To navigate between panels in an accordion container, press the Tab key to navigate to
the first panel, then use the Up Arrow and Down Arrow keys to focus on different
panels. Press the Enter key or Space bar to expand a collapsed panel or collapse an
expanded panel. When you expand an accordion panel, all other panels automatically
collapse.
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- To navigate between slides in a carousel container, press the Tab key to place focus
on the Previous Slide button. Press the Enter key or Space bar to display the previous
slide in the carousel. The slides cycle continuously, so you can navigate through the
first and last slides. Press the Tab key four more times to navigate to the Next Slide
button. Press the Enter key or Space bar to display the next slide in the carousel.

11. From the run-time menu in a basic panel container, or from a tab, the last accordion panel

header, or the Next Slide button in a carousel container, press the Tab key to place focus
on the content item. Depending on the content type, some information about the item is
read out. Use the arrow keys to navigate through text labels in a chart or values in a
report.

Press the Tab key again to navigate to the next container.

How to Assemble a Page From Existing Content in Db2 Web Query Designer

Use the following steps to create a new page from existing charts, reports, images, and other
content items.

1.
2.
3.

On the Db2 Web Query Home Page, press Ctrl + Shift + F10 to open the navigation menu.
Use the Down Arrow key to navigate to Toolbar and then press the Enter key.

While focused on the plus button, press the Enter key to open the What would you like to
do menu.

Use the Tab key to navigate to the Assemble Visualizations button, and then press the
Space bar.

Db2 Web Query Designer opens in a new browser tab, and you are prompted to choose a
template for your page.

To add a content item to the page, execute the following steps:

a. Press Ctrl + Shift + F10 to open the navigation menu.

b. Use the Down Arrow key to navigate to Resources, and press the Enter key.
Focus moves to the Outline tab, which is the first tab on the sidebar.

c. Use the Down Arrow key to navigate to the Content tab on the sidebar. Press the
Enter key or the Space bar to open it.

d. Press the Tab key to navigate to the search bar, to search for an item by name, or to
the resources tree. Use the Down Arrow and Up Arrow keys to navigate through items
in a folder, and use the Right Arrow and Left Arrow keys to navigate into and out of
folders in the repository file hierarchy.

e. Press the Enter key or the Space bar to add the item to the page. Each item is placed
in its own container. The new containers become available from the navigation menu,
S0 you can easily select them.
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To select a container on the page, press Ctrl + Shift + F10 to open the navigation menu,

and then use the Down Arrow key to navigate to Resources. Press the Enter key to move

focus to the Outline tab on the sidebar. Press the Tab key twice to enter the outline, then
use the arrow keys to navigate to the container that you want to edit.

Note that the container may have the same name as the content item within it. The
container and content item are separate components that allow a different set of
configuration options.

To resize a container, use the Shift key and an arrow key. Shift + Right Arrow expands the
container to the right, while Shift + Left Arrow contracts the container from the right.
Similarly, Shift + Down Arrow expands the container downward, while Shift+ Up Arrow
shrinks the container from the bottom. You can use the Delete key to delete the selected
container.

To configure or modify the container using the options on the Settings and Format tabs,
select the container, and then press Ctrl + Shift + F10 to open the navigation menu. Use
the Down Arrow key to navigate to Settings/Format. Press the Tab key once to focus on
the tab label. You can use the Right Arrow and Left Arrow keys to navigate to the Settings
or Format tab, and press the Enter key or Space bar to open it. Use the Tab key to
navigate to different options. You can use the Enter key or Space bar to toggle options on
or off, and type text into text boxes.

Procedure: How to Open an Existing Chart, Report, or Page in Db2 Web Query Designer

You can access any content items saved in your repository from the Workspaces view. You can
navigate to items in different workspaces, and open them from the file explorer.

On the Db2 Web Query Home Page, press the Tab key to navigate to the Workspaces
button, then press the Enter key.

Note: If you have already navigated within the page, you can return to the area that
contains the Workspaces button by pressing Ctrl + Shift + F10 to open the navigation
menu, using the Down Arrow key to navigate to the Db2 Web Query Home option, and
pressing the Enter key.

Procedure: How to Create a New Chart or Report in Db2 Web Query Designer

Build new charts and reports by selecting a content type and then adding measure and
dimension fields to the appropriate buckets.

1.

Visualizing Data

Create a new visualization in Db2 Web Query Designer and select a data source as
described in How to Create New Content in Db2 Web Query Designer on page 53.

The default content type is a stacked bar chart. Optionally, select a different chart type or
report layout from the Content picker.

a. Press Ctrl + Shift + F10 to open the navigation menu.
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10.

11.

12.

13.

b. Use the Down Arrow key to navigate to Templates, and then press the Enter key to
expand the list of available content types.

c. Press Shift + Tab and the Tab key to navigate through the list of chart types and
report layouts.

d. With focus on the content type that you want to use, press the Enter key to select it.
Next, add fields to your content. Press Ctrl + Shift + F10 to open the navigation menu.
Use the Down Arrow key to navigate to Resources and then press the Enter key.

Focus jumps to the Outline tab, on the sidebar.

Press the Down Arrow key to navigate to the Fields tab on the sidebar, and press the Enter
key to open it.

Press the Tab key multiple times until you have navigated to the top level folder in the
Dimensions area of the field list, and then use the Down Arrow and Up Arrow keys to
navigate through the list of dimension fields. You can expand a folder by using the Right
Arrow key, or collapse it by using the Left Arrow key.

With focus on the dimension field that you want to use as the primary sort field in your
content, press Shift + F10 or the Menu key to open the shortcut menu.

With focus on Add to chart or Add to report in the shortcut menu, press the Enter key. The
field is automatically added to the default dimension bucket in your content.

Optionally, add more dimension fields to your content. They are placed in the default
buckets for additional dimensions, based on the selected content type.

Once you have selected dimension fields, press the Tab key twice to enter the Measures
area of the field list. Use the arrow keys to navigate to the measure field that you want to
use.

With focus on the measure field that you want to add to your content, press Shift + F10 or
the Menu key to open the shortcut menu.

With focus on Add to chart or Add to report in the shortcut menu, press the Enter key. The
field is automatically added to the default measure bucket in your content.

Optionally, add more measure fields to your content. They are placed in the default
buckets for additional measure fields, based on the selected content type.

How to Style and Format Content in Db2 Web Query Designer

The Format tab, on the Properties panel, provides options to style and format different areas of
a chart or page. It also allows you to select a theme for your content, and change the output
format of a chart or report.
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When creating a single chart or report in Db2 Web Query Designer, all options, in the Format
tab and in other areas of the interface, apply to the item being created. When creating a page,
the Format tab provides options to style the last selected page component, which may be the
entire page, a page section, a container, the filter toolbar, a filter cell, or a content item. To
select an item in a page, use the Tab key to move focus to it, then press the Enter key or
Space bar.

1. In Db2 Web Query Designer, press Ctrl + Shift + F10 to open the navigation menu.
2. Press the Down Arrow key to navigate to Settings/Format, and then press the Enter key.

3. Press the Tab key to focus on the Settings tab, then press the Right Arrow key to move
focus to the Format tab, and press the Enter key to open it.

4. When creating a chart or report, press the Tab key to move focus to the quick access
menu. the General options display by default. When creating a chart, press the Down
Arrow key to open the quick access menu to access styling and formatting options for the
Legend, Axis, Series, and more, depending on the chart type.

When creating a page, different options appear depending on the page component that
you selected prior to navigating to the Format tab. Use the Tab key to navigate to these
options, which include themes, styles, margins, text styles, and more.

5. Once you have navigated to an option that you want to set or enable, press the Enter key
or use the arrow keys to open the control, depending on the control type. Some options
may be set using a dialog box, which you can navigate using the Tab key or the arrow
keys.

How to Add Prompted Filters to Your Content in Db2 Web Query Designer

Filters allow you to narrow down your data, providing a more focused and digestible sample.
When creating charts and reports, or pages created from new charts and reports, in Db2 Web
Query Designer, you can create prompted filters and static filters. Prompted filters apply to all
content items created within a page, and provide intuitive filter controls. When prompted filters
are added to a page created with new content, they are available at run time, allowing anyone
who accesses the page to control the data that displays.

1. In Db2 Web Query Designer, when creating a new chart or report, or a page with new
content, navigate to the field for which you want to create a prompted filter. If you select a
dimension field, a drop-down list control is created. If you select a date field, a calendar
control is created. If you select a measure field, a two-headed slider is created.

Press Ctrl + Shift + F10 to open the navigation menu, use the Down Arrow key to navigate
to Resources, then press the Enter key.

2. Press the Down Arrow key to navigate to the Fields tab on the sidebar, and then press the
Enter key.
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Use the Tab key to navigate into the field list. If you want to filter for a dimension field,
use the Down Arrow key once focus has been placed on the Dimensions folder to navigate
through the list of dimension fields. To filter for a measure field, continue tabbing until
focus is placed on the Measure Groups folder, then use the Down Arrow key to navigate
through the list of measure fields. Press the Left Arrow key collapse folders and the Right
Arrow key to expand folders, as needed.

When you have arrived at the field for which you want to create a filter, press Shift + F10
or the Menu key to access the shortcut menu.

Use the Down Arrow key to navigate to Add to filter toolbar, and then press the Enter key.

A filter prompt for the field that you selected is added to the filter toolbar.

Next, set default values for the filter. Initially, the filter is set to display all values, so no
data is filtered out.

Press Ctrl + Shift + F10 to access the navigation menu.

Use the Down Arrow key to navigate to Filter Bar and press the Enter key.Use the Down
Arrow key to navigate to Settings/Format and press the Enter key. Press the Tab key
multiple times until you arrive at the first filter control in the filter toolbar carousel. Use the
Right Arrow and Left Arrow keys to navigate to the filter for which you want to select
values.

Optionally, press Shift + F10 or the Menu key to open the shortcut menu and change filter
options.

You can choose whether a dimensional filter includes or excludes the selected values,
whether it is multi-select or single-select, and whether or not filter selections are required.

For date filters, you can choose whether the range has a start and an end point or is open
ended, and you can make filter selections required.

For numeric filters, you can choose whether or not the range is open-ended, make
selection required, and choose an aggregation to apply to the filter. By default, the sum
aggregation is applied, but you can filter on Detail values to filter based on individual
measure values from the data source, or use a different aggregation such as average or
count.

Press the Enter key or Space bar to open the filter control.
If you are filtering an alphanumeric dimension field, use the drop-down list to select filter

values. Use the Tab key to navigate to the search bar, Select all button, Clear button, list
of available values, and paging controls. Use the Space bar or Enter key to select a value.

If you are filtering a date field

If you are filtering a measure field, press the Enter key or Space bar to open the slider
control. First, use the Right Arrow and Left Arrow keys to set lower end of the slider, then
press the Tab key and use the Right Arrow and Left Arrow keys to set the upper end.
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10. When you are done setting filter values, press the Esc key to close the filter control.

Procedure: How to Apply Prompted Filters From Existing Content in Db2 Web Query Designer
Pages

If external content used prompted filters or dynamic parameters, then when it is added to a
page, you can instantly create filter controls for them.

1. Press Ctrl + Shift + F10 to open the navigation menu. Press the Down Arrow key to
navigate to Page Menu, and then press the Enter key.

Press the Tab key to navigate to the Add all filters to page button.

3. Press the Space bar or Enter key to create controls for all prompted filters or dynamic
parameters in content that was added to the page.

Creating Content in Db2 Web Query for i Designer

You can visually convey the information in your data source using a wide variety of chart types
and tabular reports with different layouts and sort orders. You can save and share content
items individually, create multiple content items as a page, or edit existing content should a
scenario change. Because of its flexibility, Db2 Web Query Designer provides you with the
platform and tools you need to create charts that communicate overall trends quickly with eye-
catching and intuitive graphics, enhanced with automatic tooltips and filtering capabilities,
reports that allow you to organize even the most granular data into an easy-to-understand
tabular format, and maps that make it easy to display geographic data to make it clear which
areas are hotspots or may deserve more investigation. You can create multiple items together
in pages for easy cross-comparison or use them as standalone components. You can then
share them with others in your organization to facilitate collaboration, which is central to
effective business practices.

Many charts, reports, and maps show contrasting intersections of data, giving you the
opportunity to share useful information that conveys patterns in your data. Db2 Web Query
Designer provides you with access to different types of simple and complex charts in a suite of
charting options. You can use simple charts to communicate important KPIs and other
straightforward metrics to get communicate information clearly and memorably. More complex
charts can be used to investigate numerous relationships between different aspects of your
data, giving you a more overarching view.

You can focus in on precise data values in a report, where you can supply large quantities of
information in a digestible format that makes it easy to identify and locate key values. A report
thereby allows you to combine a broad overview of your enterprise data with exact values for
every data point.
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Maps take the effectiveness of chart based reporting and tailor it to display geographic data.
You can communicate simple information with a basic bubble map or choropleth map, or
create maps with multiple levels to show the interplay of different metrics in locations around
the globe. You can create maps that are as precise as you need, from a regional level all the
way down to postal codes.

All of these content types can be enhanced with run-time capabilities such as prompted filters
and In-Document Analytics, which allows users to transform content and modify the display of
data at run time. For single items, you can also enable Auto Drill, which makes it possible to

navigate data hierarchies, Auto Linking which allows you to connect to and from other content
with related parameters, and Insight, which allows you to modify and build content at run-time.

Creating a visualization with new content begins with the selection of a data source, which
provides the underlying data that is used to create your content. You can select a Master file
(.mas) or a Reporting Object (.ro) as your data source.

The following image shows the default Db2 Web Query Designer interface when you create a
visualization.
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The default content type is a bar chart, but you can change it to another chart type, a report, or
a map by using the Content picker, which is located to the right of your canvas. When you
choose between the different chart types in the chart picker, you can hover over each content
type to display the name and the minimum data requirements to run it (for example, one
measure and one dimension). You also have access to a number of chart extensions from the
chart picker, which are custom-made charts that can be installed by your administrator. You
can view these by expanding the chart picker. Chart extensions display in the Custom section,
as shown in the following image.
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Selecting a Data Source

You select measures and dimensions from the Resources panel with the Fields tab selected
on the sidebar. The Resources panel displays the fields that were populated from your data
source. You can add fields to your content in the following ways: drag a field to the canvas,

double-click a field, or drag a field into one of the buckets.

Once you have created some content, you can format it to enhance its appearance or style. For
example, you might want to add a header and footer to identify your content and prepare it for
distribution. Depending on the content type, you can access targeted formatting options that
allow you to customize the Legend, Series, and Axis in a chart, the theme of a report, the
background of a map, and more. Additional options display when working with certain content
types. For example, there are special Matrix options to define the style of gridlines and labels
for a matrix chart.

If you save your content as a single item, you can add it to visualizations that reference
external content.

Alternatively, you can create multiple new content items within a single visualization. To add
more content, click the Convert to page button on the Visualization toolbar. The visualization
transforms from a stand-alone content item to a page. Select the content item with a container
to edit it with the same set of options used to edit a stand-alone content item. Once a
visualization is transformed into a multi-content page, you can add new content by clicking the
Add container button, dragging a field from the Resources panel onto an empty area of the
canvas, or by dragging a container onto the page.

If you have any multi-content containers in your visualizations, such as tabbed, accordion, or
carousel containers, you can create content by dragging a field into the toolbar area of a
container. The entire container is highlighted. When you drop the field, the Add Content dialog
box appears, prompting you to replace the content in the container or create content with the
field in a new tab, accordion panel, or carousel slide.

Selecting a Data Source
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To create a new visualization, such as a chart or report, you must first select a data source.
This data source provides the fields and values that display in your content. It can be either a
Master File, which is a data source description that allows you to structure the fields in a
database or flat file into a more logical structure, or it can be a Reporting Object, which allows
you to enhance a Master File with additional filters, default content items, and pre- and post-
processing code. Both of these data source file types enable you to create content from data
that you have uploaded or to which you have connected.
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When you launch Db2 Web Query Designer to create a new content item, you are prompted to
select a data source, as shown in the following image.
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The Select Data Source dialog box provides a file explorer that you can use to navigate to and
select a Master File or Reporting Object to use as a data source. In the default folder view, the
file explorer shows application folders containing Master Files, as well as repository folders
containing Reporting Objects and Master File shortcuts. You can navigate through levels of
folders to find the data source file that you want to use to create content.

The files shown are associated with the workspace that you select. Each workspace has an
associated application path. The application path is a set of application folders on the server
that are accessible from that workspace. Administrators can modify the application path for
each workspace in order to provide different data sources to the users in each one. This is
performed in the Properties panel on the Db2 Web Query Hub. In the Workspaces area, right-
click the workspace, click Properties, and click the Server tab. Select the Assign Application
Path check box to specify the application folders that will be available from the selected
workspace, then save your changes.
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In the Select Data Source dialog box, the workspace from which you created your content is
shown by default. You can change the workspace using the drop-down list on the toolbar at the
top of the dialog box to access data sources from different application folders, as shown in the
following image.
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Options to filter and change your view of the folders and files in the file explorer are available
on the toolbar, as shown in the following image.
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Once you navigate to a folder containing available data sources, you can use the Filter by type
menu to show only Master Files or only Reporting Objects instead of all items, so you can find
the data source that you want to use more quickly.

You can also switch from the list view to a grid view, similar to the Workspaces area on the
Db2 Web Query Hub. When in list view, you can change the columns that display to see
different information in the file explorer. You can sort these columns to find the data source
you want to use more quickly based on different properties.
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To see all data sources available from the selected workspace, switch from the folder view to

W
the flat view = . In the flat view, you can see all data sources from all folders and subfolders

in the application path and workspace. The following image shows the items from My
Workspace displayed in the file explorer when the folder view and flat view are selected.

WORKSPACE: My Workspace ~ All T H n i = Q
Type Title & Folder
= baseapp
= getting_started
z My Content
WORKSPACE: My Workspace ~ All T m n ) 4 Q
Type Title & Folder
. brakers baseapp
pd car baseapp
X carolap baseapp
X cashflow baseapp
X course baseapp
X courses baseapp
X customer getting_started
X customer baseapp
b4 ed_type_lookup baseapp
. educfile baseapp

Using the flat view may result in a very large number of data sources being shown, so if you
know where the data source that you want to use is saved, it may be easier to find using the
default folder view.

Finally, use the search bar to find a folder or data source that is currently displayed in the file
explorer by name. The file explorer is filtered based on your search query. Clear the search bar
to show all items in the file explorer again.

Once you have found the Master File or Reporting Object that you want to use as a data
source, double-click it, or select it and then click Submit, to begin creating your content.
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When you create charts, reports, and pages in Db2 Web Query Designer, the canvas displays a
design-time preview of your content. By default, the preview uses a subset of the data
available in your selected data source, saving on the resource usage required in running a full
data set, while still providing a representative and useful preview of your content.

By default, the data displayed when you design new content is a representative sample of the
records in your data source, but you can change the sample data setting to display dummy
test data or a live data selection the first records instead of a representative sample. By
default, the data displayed when you design new content is limited to 1000 records, but you
can change the sample data setting to display a representative sample from your data source
or dummy test data instead of a set of the first aggregated records. You can also choose to
display fewer or more records, and apply the record limit before or after aggregation when
using live data.

To access the sample data settings, click the data settings button I e ot o100 on the
Visualization toolbar. The Canvas Data Limit dialog box opens, as shown in the following
image.

Canvas Data Limit

Live Record Limit
O s00
@ 1000
O 5000
O 1000
O Al
O custom

Enforce limit

(O Atthe source @® Postretrieva



1. Visualizing Data I

The Canvas Data Limit dialog box includes the following options:
4 Preview data type:

4 Sample. The data shown at design time is based on a representative sample of the
records in your data source at a 99% confidence level. The sample is taken before
aggregation and stored for use as you design your content.

.4 Live. The data shown at design time is taken starting with the first records in your data
source. You can specify the number of live data records to use, and whether this limit
should be applied before or after aggregation.

.4 Test. Values from the data source are not shown at design time. Instead, generic
values are used to give a general sense of the structure and appearance of your
content.

.4 Also apply to runtime. Applies the selected data limit when the content item or page is run.
When this check box is not selected, the entire data set is used at run time.

d Record limit. When using a data sample or live data, set the number of records used to
produce the design-time preview. You can select All, 500, 1000, 5000, 10000, or select
Custom to type a value of your choice. The default for live data is 1000, limited to 1000
records, and the default for sample data is All, or the entire representative sample.

- Enforce limit. When using live data, determine when the record limit should be applied. If
you select Post retrieval, the record limit is applied after aggregation, so, for example, if the
record imit is 1000, the design-time view of your content can display up to 1000 values. If
you select At the source, the record limit is applied to your data source before aggregation,
so if the record limit is 1000, only the first 1000 records are read from the data source to
display at design time.
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document may be reproduced in any form without the written authorization of TIBCO Software
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THIS DOCUMENT COULD INCLUDE TECHNICAL INACCURACIES OR TYPOGRAPHICAL ERRORS.
CHANGES ARE PERIODICALLY ADDED TO THE INFORMATION HEREIN; THESE CHANGES WILL
BE INCORPORATED IN NEW EDITIONS OF THIS DOCUMENT. TIBCO SOFTWARE INC. MAY MAKE
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DESCRIBED IN THIS DOCUMENT AT ANY TIME.
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